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IBM Worklight V5.0.5

Upgrading an existing installation

© 2013 IBM Corporation

This presentation describes the installer included in IBM Worklight version 5.0.5 and
provides an overview of the process for upgrading your existing Worklight installation from
an earlier version to version 5.0.5.
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Upgrading Worklight Studio
using the Eclipse update-site

2 Upgrading an existing installation © 2013 IBM Corporation

The Eclipse update-site can be used to upgrade Worklight Studio on Windows®, Linux®,
and MacOS.

Worklight505_upgrade.ppt Page 2 of 44



= Get p2 update site .zip file from the IBM External Delivery Site

3 Upgrading an existing installation © 2013 IBM Corporation

To use the Eclipse update-site to upgrade Worklight Studio, you need to have the required
versions of Eclipse and JRE installed. Then download the p2 update site .zip file on the
IBM External Delivery Site.
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Upgrading Worklight Studio (1 of 4)

TR X e —

Fie Ean Navgwe Sewch Proecfun- Windon BB

1 O E I  Weicome . & Welcome
dhg i O e
“ Dynamic Help
2. In the Help menu, select “Install New : Key s Cutesnttt
» Welcome to Eclipse  risansics
Software. .. Chan Shees.
Y Overview Ao0u-
3. In the Install window, click the “Add...” Wgae S

button

4. In the Add Repository window, use the e 3 1 3%
‘ Ca
D =

“Archive...” button to locate the .zip image Avalble Software
Select a site or enter the location of a site.

and then enter a name, for example “IBM H

Worklight Studio” P |
Find more software byrwo«mqiwwmt Avadable Software Sites” preferences.
5. Click “OK” to close the Add Repository ypehwten | @ Add hepusoy
window rerree | (C Loy
Location: IN/Desitop/imp-update-site-1.0.0-20120502.023019-65 zipl/
| @  —— Cancel
Select Al ‘
4 Upgrading an existing installation © 2013 IBM Corporation

To upgrade Worklight Studio, the first step is to enter the location of the .zip image you
downloaded. This step is needed because the .zip file for version 5.0.5 has a different
name than earlier versions.
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8. Click “Next” on the update panel

5 Upgrading an existing installation

Jjrading Worklight Studi

D (

6. Click “Cancel” in the Install window

2

(0)

f4)

7. In the “Help” menu, select “Check for Updates”

9. Verify the items to be updated and click “Next”

Available Software

Add.

Setect Al esetect Al

8] Available Updates

Update Details

Review and confirm the updates.

¢ IBM Worldight Studio

Size: 16,122 KB
Details

2 < Back

K <=>)

Cancel

© 2013 IBM Corporation

Cancel the installation because you want to upgrade, not perform a fresh installation.
Then, in the Help menu, select “Check for Updates”. While going through the panels using
the “Next” button, you can always use the “Back” button to change your earlier choices.
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Upgrading Worklight Studio (3 of 4)

& Available Updates

Review Licenses

Licenses must be reviewed before the software can be installed. This includes licenses for software requi

10.Click “Next” again togo tothe | ___
Review Licenses panel

onal Program License Agreement for

11.Select“| accept...” and

o You will need to restart Eclipse SDK for the installation changes to take effect. You may try
1o apply the changes without restarting, but this may cause errors.

[ Not Now Apply Changes Now

6 Upgrading an existing installation

click the “Finish” button Bai e
12.The upgrade takes some time
13.Restart Eclipse when promptec - =D
& Updatng Software =l -
0 Updating Software
P— | Te—
Always run in background
[ Backgpound) | Cancel P
& Software Updates e ﬂ

© 2013 IBM Corporation

On the Review Licenses panel, you should read each license in the list before accepting
all of them at the same time. When you click Finish, the upgrade starts. When the upgrade

completes, you are prompted to restart Eclipse.
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Upgrading Worklight Studio (4 of 4)

& install - - 8- =) -
Available Software !’__‘
. H » ck the items that you wish 1o instal =
Install new feature “IBM jQuery Mobile Tools o
14.In the “Help” menu, select “Install New 1BM Worklight Studio - jacfile/C/1LOG/IMP/iws.eclpse 50550+ | Add
Software_ . » Find more software by working with the A tes” preferences.
15.1n the “Work with” field, select the ype et
- Name Version
newly downloaded zip and select the ‘. 6 Woright Studio for IBM Workight
BM Dojo Mobile Tools 5.0.5 v2012]
feature V|5 1BM jQuery Mobile Tools g3 52 zg v?glii
1 6 C||Ck “Next” to proceed Ow Worklight Studio 5.0.5000.v20121
17 . Verify the item to install and click
uNeXtu Select All Deselect All 1 item selected

18.0n the Review Licenses panel, select iy

V! Show only the latest versions of available software

Hide items that are already installed
“l accept” and click “Finish” ] Group items by category Wnatis alea
19.The installation will take some time B e st
20.Restart Eclipse when prompted
2 Cancel

7

Upgrading an existing installation ©2013 IBM Corporation

At this point in the upgrade process, you have updated the features that were part of your
existing installation. The final step in the upgrade is to install a new feature called “IBM

jQuery Mobile Tools” that is available in Worklight version 5.0.5. In the Available Software
panel, the features you have already installed are visible but unavailable. The IBM jQuery

Mobile Tools feature is available because it is not yet installed. Select this feature and
proceed with its installation.
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Upgrading with Installation Manager

(Passport Advantage integration)

8 Upgrading an existing installation © 2013 IBM Corporation

The next section of this presentation is dedicated to upgrading Worklight with Installation
Manager, which can be used on Windows or UNIX®, but not Macintosh.
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= |BM Installation Manager V1.6

9 Upgrading an existing installation © 2013 IBM Corporation

If you do not have IBM Installation Manager on your machine, you need to install it.
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Entering your credentials (1 of 2)

1. Launch IBM Installation Manager

2. In the “File” menu, select “Preferences...”

‘ Installation History
4 View Installed Packages
r Install
:
Install software packages.
Exit
Update
\ Discover and install .
updates and fixes to J Ma“age Licenses
installed software
packages.
Roll Back
Modify
¥ V Change installed software
- packages by adding or Q Uninstall
removing features and
functions.
IEM.
10 Upgrading an existing installation

© 2013 IBM Corporation

The first step, when upgrading Worklight with IBM Installation Manager, is to enter your
credentials for the product you purchased. On the main window of IBM Installation
Manager, open the “File” menu and click “Preferences...”. This will open the Preferences

window.
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erences
Repositories
Appearance

Help
ntem:

Updates

Files for Rollback

Entering your credentials (2 of 2)

4. On the right side, check the “Connect to Passport Advantage” box
5. Enter your credentials in the popup window and click “OK”

Passport Advantage

onrw:d to Passport Advantage

Passport Advantage!

) Password Required

Put your
Password Required IBM ID

Credentials are required to connect to the IBM download site. here
Enter IBM ID and password. I

User name: |
Password:
Save password

. Saved passwords are stored on your computer in a file which is
difficult, but not impossible, for an intruder to read

3. In the “Preferences” window, select Passport Advantage® from the list on the left side

W

1 Upgrading an existing installation

© 2013 IBM Corporation

In the Preferences window, select the Passport Advantage item from left side. Then, on
the right side, check the “Connect to Passport Advantage” box. This will open a new
window prompting you to enter your IBM ID and password. If you need help with your IBM
credentials, see the links at the bottom of the window. Then click “OK”. If the Preferences
window is still open, click “OK” to close it.
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Updating Worklight Studio (1 of 7)

Update

Discover and install
updates and fixes to

installed software
1. Click “Update” on main window Bectages
‘msmnmm
Update Packages

Select a package group to find updates for.

Package Group Name

‘s IBM Software Delivery Platform
- Worignt

Directory
C\Program Files (x86)\IBM\SDP
CAProgram Files (x86)\IEM\Worklight

Details = |
Workiight
* Shared Resources Directory: C:\Program Files (xB6)\IBM\IBMIMShared

1

* Installation Directory: C:\Program Files (<86)\IBM\Worklight IBM WebSphere Application Server V&5

IDE: C:\Program Files (xBE)\IBM\Workight

* Translations: English
* Architecture: 32-bit
Installed Packages and Fixes

* IBM® Workight Server for IBM® Mobile Foundation Consumer Edition 5.0.0

2. Selectthe package to update or check ‘Update all’ and click “Next”

12 Upgrading an existing installation

© 2013 IBM Corporation

On the main window of IBM Installation Manager, click the Update button. This launches
the installation wizard, which displays the offering packages you have access to. You can
select one package; or you can select all packages using the ‘Update all’ check box. In
this example, Worklight Studio — IBM Software Delivery Platform is selected. Click “Next”.
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Updating Worklight Studio (2 of 7)

M SR M

Update Packages
Select the updates to install.

Update
4 [@] % IBM Software Delivery Platform
4 [#]© 1BM® Worklight Studio fo

' |[¥ Version 5.0.5

¥| Show recommended only

@ < Back

h=1

Recommend.. Vendor

v/ IEM

Select Recommended

: Cancel

3. Click “Next”

13 Upgrading an existing installation

© 2013 IBM Corporation

Review the information provided. Make sure it is the correct edition of Worklight. Click

Next.
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Updating Worklight Studio (3 of 7)

Update Packages
Validate the prerequisites for the selected packages. Click the marked nodes for additional information about prerequisites.

ate Prerequisite censes Features Summar

Validation Results

5 IBM® Worklight Studio for IBM® Mobile Foundation Consumer Edition 5.0.5 || Waming! Before proceeding with the

www.ibm.com/support.

T ) [ opom

‘| installation, you should stop any applications
that are running, including anti-virus software.
" Anti-virus software or other applications that are
running might interfere with the installation
process. For more information, see http://

| Recheck Status |

Cancel

4. Click “Next”

N Upgrading an existing installation
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Read this information and click “Next”.
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Updating Worklight Studio (4 of 7)

Read the following license agreements carefully.

4 [BM® Worklight Studio for IBM® Mobile Foundation Consumer Edition
License Agreement Mobile Foundation Consumer Edition
License Agreement Mobile Foundation Enterprise Edition
License Agreement Worklight Consumer Edition
License Agreement Worklight Enterprise Edition
Non-IBM Terms

1BM M - o
Update Packages = ’
R

International Program License Agreement
Part 1 - General Terms

BY DOWNLOADING, INSTALLING,

COPYING, ACCESSING, CLICKING ON AN
"ACCEPT" BUTTON, OR OTHERWISE

USING THE PROGRAM, LICENSEE AGREES
TO THE TERMS OF THIS AGREEMENT. IF
YOU ARE ACCEPTING THESE TERMS ON
BEHALF OF LICENSEE, YOU REPRESENT

AND WARRANT THAT YOU HAVE FULL
AUTHORITY TO BIND LICENSEE TO THESE _

< 1 »
TEOAAC IE VALLNA MAT AGDEE TN TUCEE
@ [ accept the terms in the license agreements Print All.
1 do not accept the terms in the license agreements - o
@ < Back J s Next > 2 ate Cancel
5. Click “Next”
15 Upgrading an existing installation

© 2013 IBM Corporation

This panel of the installation wizard shows the license agreements. Read the license
agreement for the edition of Worklight you are installing. Also read Non-IBM Terms. Then

select the “| accept...” radio button and click Next.
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IBM Installation M

Updating Worklight Studio (5 of 7)

Update Packages

Select the features to install

Features

| Core Development Tools

v jQuery Mobile Tools
¥ | Dajo Mobile Tools and library

< Back

- Jl [) IBM® Worklight Studio for BM® Mobile Foundation Consumer Edition 5.0.5

[z |

Status

New

Cancel

6. Click “Next”

16 Upgrading an existing installation

© 2013 IBM Corporation

This panel allows you to select the features that you want to install. Core Development
Tools is required and cannot be cleared. jQuery Mobile Tools is a new feature in Worklight
version 5.0.5. In this example, all features are selected. Click Next.
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Update Packages

Review the summary information.

Target Location
Package Group Name:
Installation Directory:

Updates

Features To Install

Core Development Tools
¢ jQuery Mobile Tools
- Dojo Mobile Tools and library

Disk Space Information
Total Available Space
(63 1201G8

Total Download Size: 23113 M8
Total Installation Size: 358.14 M8

» Repository Information

Updating Worklight Studio (6 of 7)

1BM Software Delivery Platform_1
C\Program Files (x86)\IBM\SDP_1
Shared Resources Directory: C:\Program Files (x86)\IBM\IBMIMShared

4 [ IBM® Worklight Studio for IBM® Mobile Foundation af

Features To Remove
IBM® Worklight Studio for IBM® Mobile Foundation
0 Rich Page Editor

< Back at r Update ] Cancel

7. Click “Update”

17 Upgrading an existing installation
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Review the information in the Update summary panel, especially the Features To Install.

Then click Update.
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Updating Worklight Studio (7 of 7)

- . El S
Update Packages

[y

@) 1 psctaces e eI ]

The following update was installed:
Update
IBM Software Delivery Platform
1BM® Worldight Studio for IBM® Mobile Fo

Installation Directory
CA\Program Files (x8.
undation Consumer Edition 5.0.5

8. Click “Finish”

18 Upgrading an existing installation

© 2013 IBM Corporation

During the update, a progress bar is displayed. You can pause or cancel the update.
When the update completes, the resulting status is displayed at the top of the panel. You

can use the View Log File link to view the update log file. Click Finish.
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Starting the update of Worklight Server (1 of 4)

1.

Update

» Discover and install
updates and fixes 1o

Click “Update” in main window g e

Update Packages

Select a package group to find updates for.

Package Group Name Directory

IBM Software Delivery Platform CAProgram Files (B6N\IBM\SDP
C\rogram s b B Worsign
Update all
Details = |
Worklight
= Shared Resources Directory: C:\Program Files (x86)\IBM\IBMIMShared

= Installation Directory: C:\Program Files (x86)\IBM\Waorkiight

DE: C:\Program Files (x86)\IBM\Worklight

Installed Packages and Fixes
« IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.00

2. Select package to update or check ‘Update all’ and click “Next”

19 Upgrading an existing installation

© 2013 IBM Corporation

The next step is to update Worklight Server. The process is very similar to the one you just
followed to update Worklight Studio. On the main window of IBM Installation Manager,
click the Update button. This time, select the Worklight package. Then click “Next”.
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Starting the update of Worklight Server (2 of 4)
R .~ —
Update Packages ,jj
Select the updates to install. U=
Update Recommend.. Vendor
4 V| % Worklight |
+ [#]© 1BM® Worklight Server for IBM® Mobile Fo
' |¥ Version 5.0.5 v IBM
+| Show recommended only Select Recommended
@ L < Back Update Cancel
= Click “Next”
20 Upgrading an existing installation © 2013 IBM Corporation

Review the information provided, especially the edition, and click Next.

Worklight505_upgrade.ppt Page 20 of 44



Starting the update of Worklight Server (3 of 4)

f =0, x

Update Packages =

Read the following license agreements carefully. Nl

dates Licenses Features Summary

IBM® Worklight Server for BM® Mobile Foundation Consumer Edition| International Program License -
License Agreement Mobile Foundation Consumer Edition Agreement = '
License Agreement Mobile Foundation Enterprise Edition
License Agreement Worklight Consumer Edition
License Agreement Worklight Enterprise Edition

Part 1 - General Terms

BY DOWNLOADING,
Non-IBM Terms INSTALLING, COPYING,
ACCESSING, CLICKING ON AN
"ACCEPT" BUTTON, OR
OTHERWISE USING THE
PROGRAM, LICENSEE AGREES
TO THE TERMS OF THIS
AGREEMENT. IF YOU ARE

ACCENTING TUCCE TEDAC NN

© I accept the terms in the license agreements Print All.|

1 do not accept the terms in the license agreements

® [ <Back ‘ r@, pdate | Cancel |

= Click “Next”

21 Upgrading an existing installation © 2013 IBM Corporation

Read the license agreement for your edition and Non-IBM Terms. Select the “I accept...”
radio button and click Next.
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Starting the update of Worklight Server (4 of 4)

[ o vt ~=
Update Packages =

Select the features to install.

Features
v | IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.0.5

< Back ‘| Cancel

= Click “Next”

2 Upgrading an existing installation © 2013 IBM Corporation

Verify that the correct feature is selected and click Next.

The next few panels pertain to database updates. Depending on which database is
installed on your machine, the panels are different or even disabled. Also, you might see
some panels not shown in this presentation.
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23

Upgrading Derby databases

= Derby initially installed
fﬁm

Update Packages
il i e contguration ox

the pxctages.

Upgrading an existing installation

© 2013 I1BM Corporation

If your existing installation of Worklight Server is using Derby, you will be asked to choose
one of the following three options. The first option is to reuse the existing databases. If you
choose this option, the existing databases will be updated. The second option is to create
new databases in a new repository. And the third option is to delete the existing databases
and re-create them in same directory. If you choose this option, you will be prompted to
confirm your choice.
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Upgrading DB2 databases

= DB2® pre-installed

) B irseataton Varager < -

Update Packages
£ e contrasions or e

2% Upgrading an existing installation

Cancl

© 2013 IBM Corporation

If your existing installation of Worklight Server is using DB2, you are offered the
opportunity to change the password Worklight uses to access DB2, since it might have
changed. Once the installation wizard has finished creating the APPCNTR database, the

last Next button will become available. Click it to proceed.
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Upgrading MySQL databases

= MySQL pre-installed (since version 5.0.0.3)

[AEC=EEoee @

P s =

25 Upgrading an existing installation © 2013 IBM Corporation

If your existing installation of Worklight Server is using MySQL, you are offered the
opportunity to change the password Worklight uses to access MySQL. Also, you might see
a warning message recommending that you increase the value for a particular MySQL
variable in order to have a better experience with the Worklight product. If you get one of
these messages, you will also get a browser window with a page that explains the
variable.
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Changing your database repository (1 of 7)

= Another database

Update Packages =

Fill in the configurations for the packages.

D IBM® Worklight Server for IBM® Mobile I C for IBM® ight Server for IBM® Mobile Foundation Consumer
& Choose your database type Edition 5.0.5 h
O Database server properties Choose your database type

Create databases
Databases creation progress
Choose your application server type
© Application server properties
© Multiple users (optional) IBM DB2 Enterprise Server Edition V9.7 and later | ]
MySQL 5.1 and later
Oracle 11g Standard/Entreprise Editions Release 1 and later

Database choice

Use pre-installed database server (should be running)

Install Apache Derby 10.8 Release (not for production use)

» « [

? < Back o Cancel 'l

— Click “Next”

26 Upgrading an existing installation © 2013 IBM Corporation

If your existing installation of Worklight Server is using different type of database, then, as
part of this upgrade, you have to change databases. You can choose to use an existing
database, as long as it is of one of the types listed on this panel. Or you can install Derby.
Once you make a section click Next.
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— Derby

Changing your database repository (2 of 7)

For 1 type of datasase the et

27 Upgrading an existing installation

cessary dutabases w be Ceated
storatica®y 2 divectory C\ProgramOntaUBM\WorkSght\derby.

© 2013 IBM Corporation

If you choose to install Derby, no settings are required. Click Next four times.

Worklight505_upgrade.ppt

Page 27 of 44



Changing your database repository (3 of 7)

—MySQL

Update Packages

Fill in the configurations for the packages.

IBME Worklight Server for 1BME Mobile | Configuration for IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.0.5
B Choose your database type Database server properties
& Database server properties

Create databases SR e
Databases creation progress
Choose your application server type | Worklight uses three databases WRKLGHT, WLREPORT. and APPCNTR on the MySQL database server
Naciication sicues Sicperies These databases may or may not exist yet. if they dont exist. you can create them through the next
panel
Multiple users (optional !

Enter the settings that Worklight should use 10 access these databases.

Network settings
Host name (ex localhost

Port 3306

Password
MySQL Connector/J JOBC Driver
Path to jar file: Browse ...
[Mysm JDBC driver download: hitp W.MysQ! 2 ector// l

<Back () Cancel

— Provide required information and click “Next”

28 Upgrading an existing installation © 2013 IBM Corporation

If you select an existing database, you are required to enter the related settings. Port has
a default value, but you can change it if necessary. If you need help filling in the fields, see
the links provided.
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Changing your database repository (4 of 7)

-DB2 —Oracle

Oracle database settings
DB2 database settings

Worklight uses three databases WRKLGHT, WLREPORT, and APPCNTR on the Oracle database
server. These databases may or may not exist yet; if they don't exist, you can create them through the
next panel.

Worklight uses three databases WRKLGHT, WLREPORT, and APPCNTR on the DB2 database server,
These databases may or may not exist yet; if they don't exist, you can create them through the next
panel

Enter the settings that Worklight should use to access these databases.
Enter the settings that Worklight should use to access these databases.

Network settings
Host name (ex: localhost):

Network settings

Host name (ex: localhost.

Port: 1521
Port: 50000

tjind its password for accessing the databases. If the databases do not

tjnd its password for accessing the databases.

yet exist, this User accou! an be created for each database in the next panel, with the user name and

User name: password that you specify here.

Password: User name:
Password

1BM DB2 Driver for JDBC

Path to jar file: Browse ... Oracle 11g JDBC Driver

| DB2 driver downioad: http://www-0Libm.cony/suppar/docview s uid =sng21363866 | Path to jar file Browse ...
Oracle JDBC driver download: hitp://www.oracle /technetwork/database/features/idbc/index I
29 Upgrading an existing installation ©2013 IBM Corporation

Depending on which type of existing database you choose, the required information is a bit
different. Once you fill in the fields, the Next button becomes enabled. Click it to proceed.
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— Databases exist

Create MySQL databases
The required MySQL databases already exist.

— Create MySQL databases

Updale Packages
O wre " pas

0ng user name of password

abases

Create MySQL databases

Changing your database repository (5 of 7)

2 Mobile Configuration for IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.0.5

sses WRKLGHT, WLREPORT. APPCNTR
GHT, WLREPORT, APPCNTR dlo not yet exist. Either create them mancal
ary details here and dlick

Create DB2 databases
The required DB2 databases already exist.

— Provide required information and click “Next”

30 Upgrading an existing installation

© 2013 IBM Corporation

Before this panel is displayed, the installer checks whether or not the databases already
exist on your machine. If the databases already exist, then just click Next, twice. If the
databases do not exist, then you have two choices. You can let the installer create them
for you, by filling in the fields on this panel and clicking Next. Or you can create the
databases manually. If you choose to create the databases manually, after creating the
databases, you need to use the Back button to go to the previous panel and then click
Next again. The installer will behave as if the databases existed from the beginning.
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Changing your database repository (6 of 7)

— Create DB2 databases

Create DB2 databases
Preparing to create the databases WRKLGHT. WLREPORT. APPCNTR.

The required databases WRKLGHT. WLREPORT. APPCNTR do not yet exist. Either create
them manually and click *Back®, or enter the necessary details here and click *Next*

For this operation, the database server needs to have an SSH daemon running.

Database instance: db2instl v

The specified user ‘wiStest' does not have the permissions to create the databases. Enter
the name and password of a user account on the database server that has the DB2

rivilege SYSADM or SYSCTRI

Admin user name:

Admin user password

— Create Oracle databases

Create Oracle databases
Preparing to create the databases WRKLGHT, WLREPORT, APPCNTR

The required databases WRKLGHT, WLREPORT, APPCNTR do not yet exist. Either create
them manually and click "Back", or enter the necessary details here and click "Next"

For this operation, the database server needs to have an SSH daemon running

Enter the operating system login and password of the Oracle database administrator.
Administrator login name:  oracle

Administrator password

Enter passwords for the users SYS and SYSTEM of the new databases

Password for user SYS:

Confirm password for user SYS:

Password for user SYSTEM:

Confirm password for user SYSTEM:

31 Upgrading an existing installation
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If you choose to let the installer create the databases for you, then, depending on the type
of database repository installed on your machine, the required information is a bit different.
Once you fill in the fields, the Next button becomes enabled. Click it to proceed.
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Update Packages 3. |

Fill in the configurations for the packages.

U IBM® Worklight Server for IBM® Mobile = Configuration for IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.0.5 ‘

@ Choose your database type Databases creation progress
|} @ Database server properties

& Create databases Creating MySQL databases...
| © Databases creation progress
|} © Choose your application server type Creating database WRKLGHT... done
'} O Application server properties Creating database WLREPORT... done
| © Multiple users (optional) Creating database APPCNTR... done

Databases successfully created.

| |
|
The required databases now exist. Click "Next™ to continue.
|}
|
|}

e J(CEES] [ ==

Creating database WRKLGHT (this may take 5 minutes) ... done

o
Creating database WLREPORT (this may take 5 minutes) ... done
Creating database APPCNTR (this may take 5 minutes) ... done Creating Oracle databases... =
Databases successfully created.

Creating database WRKLGHT (this may take 15 minutes) ... done
Creating database WLREPORT (this may take 15 minutes) ... done
Creating database APPCNTR (this may take 15 minutes) ... done
Databases successfully created

The required databases now exist. Click "Next* to continue

The required databases now exist. Click *Next* to continue.

— Click Next

2 Upgrading an existing installation
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Once the installer finishes creating the database tables, click Next.
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Application server updates - WebSphere Application Server Liberty

i rsaisson

= WebSphere® Application Server Liberty profile initially installed

3 Upgrading an existing installation ©2013 IBM Corporation

The next panels in the installer are related to application server updates. Depending on
which application server your existing Worklight installation uses, these panels are
different or even disabled. The installer for version 5.0.5 contains some new panels that
were not in earlier versions.

If your existing Worklight installation uses WebSphere Application Server Liberty Profile as
its application server, you just click the Next button, twice.
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Application server updates — WebSphere Application Server

= WebSphere Application Server pre-installed (since version 5.0.0.3)

34 Upgrading an existing installation © 2013 IBM Corporation

If your existing installation of Worklight uses WebSphere Application Server, you have the
opportunity to change the password that Worklight uses to access it. Then click Next,
twice.
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Application server updates - Tomcat

= Tomcat pre-installed (since version 5.0.0.3)

35 Upgrading an existing installation © 2013 IBM Corporation

If your existing Worklight installation uses Tomcat, you just click Next, twice.
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Single or multiple users

Update Packages Y=

Fill in the configurations for the packages.

4 1) IBM® Worklight Server for IBM® Mobile Configuration for IBM® Worklight Server for IBM® Mobile Foundation Consumer Edition 5.0.5
@ Choose your database type Multiple users (optional)
© Database server properties
© Create databases
@ Databases creation progress Only the specified set of users can:
© Choose your application server type « Start and stop the application server.

This product can be installed for a single user or for multiple users.

@ Application server properties « Access and modify the Derby databases.

& Muitiple users (optional)
Security warning
The multi-user installation works for any user in a given group, It assumes that each of the users in the group trusts all
other users in the group. Any user in the group can trick any other user in the group into executing arbitrary code.

Select the installation mode:
9 Single user

Multiple users

Enter the operating system user name.
1BM-082194 v\ -

T ) Cancel )

= Choose your installation mode, provide required information and click Next

36 Upgrading an existing installation © 2013 IBM Corporation

This panel lets you choose whether you want Worklight to be installed for a single user or
for multiple users. Read the information on this panel, especially if a security warning is
displayed. The information is slightly different depending on your operating system and the
type of application server you are using.
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Finishing the update of Worklight Server (1 of 2)

Update Packages =

Review the summary information. N

Target Location

Package Group Name: Worklight

Installation Directory: C:\Program Files\IBM\Worklight I
Shared Resources Directory: C:\Program Files (x86)\IBM\IBMIMShared
; Updates | '
| Features To Install Features To Remove i
) IBM® Worklight Server for IBM® Mobile Foundation Consumer

Disk Space Information
Total Available Space
C 1116 GB

Total Download Size: 177.61 MB 2

@ < Back Next [ CUpdate) | Cancel

\ i
= Click “Update”

37 Upgrading an existing installation © 2013 IBM Corporation

Review the information on this panel, especially the Feature To Install. Click Update.
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= Click “Finish”

38 Upgrading an existing installation

Update Packages

Finishing the update of Worklight Server (2 of 2)

)

© 2013 IBM Corporation

During the update, a progress bar is displayed. You can pause or cancel the update.
When the update completes, the installer displays the resulting status of the update at the
top of the panel. You can view the update log file by clicking the View Log File link. Click

Finish.
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Shortcuts on Windows and Linux

IBM Worklight
Application Center
Start server

= Worklight Server update creates shortcuts Stop server
in Start menu for Windows Worklight Conenle

Web Resources

@ Blogs

& Education Assistant

& Forums

@ IBM Mobile Platform Web Site
@ Infocenter

@ Online support

@ Worklight on developerWorks

and Applications for Linux @ ©="wekion G @ Vb resouees ® [

@ Application Center @ Education Assistant

@ Start server @ Forums
@ Stop server @ IBM Mobile Platform Web Site
@ Worklight Console @ Infocenter

@ Online support

@ Worklight on developerworks
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The Worklight installer creates several shortcuts in the Start menu on Windows platforms
and in Applications on Linux platforms. These shortcuts allow you to access all
documentation, and launch Application Center and the Worklight console.
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Uninstalling

40 Upgrading an existing installation © 2013 IBM Corporation

The process for uninstalling Worklight V5.0.5 is covered in the IBM Education Assistant
module about performing a fresh installation. Since you upgraded to version 5.0.5 from a
previous version of Worklight, you will see one difference from the panels shown in that
module. The Eclipse update site will have one additional feature, the IBM Rich Page
Editor, which comes from versions of Worklight before version 5.0.5.
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41 Upgrading an existing installation

Summary

© 2013 IBM Corporation

In summary . ..
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= Update Worklight Studio
— Eclipse update-site
— IBM Installation Manager

= Update Worklight Server
— |IBM Installation Manager

42 Upgrading an existing installation © 2013 IBM Corporation

You can upgrade Worklight Studio and Server to version 5.0.5 using IBM Installation
Manager, which is supported by many IBM products. It provides a consistent user
installation and upgrade experience. However, it is not available for Macintosh. IBM
Worklight Studio can also be upgraded as an Eclipse plug-in from an update-site. This
does work on Mac platforms.
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IBM Installation Manager information center

IBM Worklight V5.0.5 documentation

Eclipse SDKV3.6.2

Eclipse SDKV3.7.2

43 Upgrading an existing installation © 2013 IBM Corporation

This slide contains links to the IBM Installation Manager information center and IBM
Worklight version 5.0.5 documentation.
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Trademarks, disclaimer, and copyright information

IBM, the IBM logo, ibm.com, DB2, Passport Advantage, and P are trad rks or registered trademarks of International Business Machines
Corp., registered in many jurisdictions worldwide. Olher producl and service names mlght be trademarks of IBM or other companies. A current list of
other IBM trademarks is available on the web at "Copyriaht and formation” at http://www.ibm.com/legal/copytrade.shtml|

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Windows, and the Windows logo are registered trademarks of Microsoft Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

THE INFORMATION CONTAINED IN THIS PRESENTATION IS PROVIDED FOR INFORMATIONAL PURPOSES ONLY. WHILE EFFORTS WERE
MADE TO VERIFY THE COMPLETENESS AND ACCURACY OF THE INFORMATION CONTAINED IN THIS PRESENTATION, IT IS PROVIDED
"AS IS" WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. IN ADDITION, THIS INFORMATION IS BASED ON IBM'S CURRENT
PRODUCT PLANS AND STRATEGY, WHICH ARE SUBJECT TO CHANGE BY IBM WITHOUT NOTICE. IBM SHALL NOT BE RESPONSIBLE FOR
ANY DAMAGES ARISING OUT OF THE USE OF, OR OTHERWISE RELATED TO, THIS PRESENTATION OR ANY OTHER DOCUMENTATION.
NOTHING CONTAINED IN THIS PRESENTATION IS INTENDED TO, NOR SHALL HAVE THE EFFECT OF, CREATING ANY WARRANTIES OR
REPRESENTATIONS FROM IBM (OR ITS SUPPLIERS OR LICENSORS), OR ALTERING THE TERMS AND CONDITIONS OF ANY AGREEMENT
OR LICENSE GOVERNING THE USE OF IBM PRODUCTS OR SOFTWARE

© Copyright International Business Machines Corporation 2013. All rights reserved

44 © 2013 IBM Corporation

Worklight505_upgrade.ppt Page 44 of 44



